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Introduction to HelpLogic 1.6

What is HelpLogic?
In a nutshell, it is the essential help authoring solution for Mac
developers. Easily create help systems for your software
applications and web sites from a single source!

This User Guide was built with HelpLogic!

HelpLogic's award-winning design removes the development
headaches usually associated with help authoring. With time-
saving features like the built-in Visual TOC Builder, Project Workshop, HTML Editor,
Link Manager and more, HelpLogic is the ideal solution for software developers, help
authors, web site designers, and documentation writers.

For details on what's new in this version, please read the Release Notes. For more
information on the Trial Edition or How to Purchase a license, please see those
respective pages. HelpLogic 1.6 is a free upgrade for existing HelpLogic customers.
Still using the limited Trial Edition? Purchase HelpLogic for only US $99 -- Order
online today at http://www.ebutterfly.com/helplogic/

HelpLogic, created by Electric Butterfly, Inc. For the latest news and product
updates, check out the official HelpLogic web site at:
http://www.ebutterfly.com/helplogic/

 
Copyright © 2002-2009 Electric Butterfly, Inc. HelpLogic  and UniHelp are trademarks of Electric Butterfly, Inc.
Mac and Apple Help are trademarks of Apple Computer,  Inc. Microsoft is a  registered trademark of Microsoft
Corporation. All  rights  reserved.
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Creating a New Project

Step 1: Launch HelpLogic

When launched for the first time, you will be prompted to either accept or decline the
HelpLogic end user license agreement. The next screen that automatically displays
(until  the application is registered) is the Register window. If you wish to evaluate
HelpLogic, click the "Later" button to continue.

Step 2: New Project

From the Welcome screen, click the "New Project" button and the application will
walk you through the process of creating a new HelpLogic Project. You can also
select "New Project" from the File Menu to create a HelpLogic project.

Give your project a name (you can give your finished help system a different name
when publishing) and then tell HelpLogic where you want to save your new project.
Upon clicking the "Create" button, HelpLogic generates a new project folder in that
location that contains your HelpLogic project file, along with a "Source" folder that
will hold the HTML help pages you create in your project.

Step 3: Main Project Window

The main project window that appears is the heart of the HelpLogic application. The
interface design provides a very intuitive, time-saving workflow for easily creating,
editing, and managing your project's table of contents, related HTML source files,
and project development notes, saved code snippets, etc. For a quick overview on
HelpLogic basics, please read the How to Use HelpLogic page, or browse the rest
of this User Guide for details on specific features.
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Opening Existing Projects

Step 1: Launch HelpLogic

If you have not yet registered HelpLogic, the first window that appears is the
Register window. If you are still evaluating HelpLogic (and not yet ready to
purchase), click the "Later" button to continue.

Step 2: Welcome Screen

Once the Welcome screen is displayed, click the "Open Project" button, or select
"Open Project" from the File Menu to open an existing HelpLogic project file.

From the Open dialog window that appears, simply select a HelpLogic project file
(with an .ehp file extension) to open it.

You can also choose a recently opened HelpLogic project by selecting it from the
"Open Recent" menu.

You can also open a HelpLogic project by double-clicking on the .ehp project file or
by dragging and dropping the project file onto the HelpLogic application icon.

Step 3: Main Project Window

The main project window that appears is the heart of the HelpLogic application. The
interface design provides a very intuitive, time-saving workflow for easily creating,
editing, and managing your project's table of contents, related HTML source files,
and project development notes, saved code snippets, etc. For a quick overview on
HelpLogic basics, please read the How to Use HelpLogic page, or browse the rest
of this User Guide for details on specific features.
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Importing Set of Pages

If you have an existing set of HTML pages that you would like to use for your help
system, you can import the entire set of pages into a new HelpLogic project with the
"Import Set" feature.

Step 1: Launch HelpLogic

If you have not yet registered HelpLogic, the first window that appears is the
Register window. If you are still evaluating HelpLogic (and not yet ready to
purchase), click the "Later" button to continue.

Step 2: Import Set

From the Welcome screen, click the "Import Set" button and then select from the
Import Options that are presented. You can also select "Import Set" from the File
Menu.

Give your project a name (you can give your finished help system a different name
when publishing) and then tell HelpLogic where you want to save your new project.
You also need to specify where your existing folder of HTML pages are located, so
that HelpLogic can import a copy of them into your new project. Upon clicking the
"Create" button, HelpLogic generates a new project folder that contains your
HelpLogic project file, along with a "Source" folder that holds a copy of the entire set
of HTML pages you chose to import (this also includes all related images and media
files from your imported folder).

Importing Old UniHelp 1.x Pages: When importing your old UniHelp 1.x Pages into
a new project (using the "Import Set" feature), the project's Table of Contents is
automatically generated based on your UniHelp 1.x file naming and numbering
scheme. You will still need to add your own custom keywords to the TOC topics, but
the generated TOC will have saved you a lot of time when publishing your help
pages in other help formats that use the TOC (such as UniHelp 3, Web-based Help,
etc.)

Step 3: Main Project Window

The main project window that appears is the heart of the HelpLogic application. The
interface design provides a very intuitive, time-saving workflow for easily creating,
editing, and managing your project's table of contents, related HTML source files,
and project development notes, saved code snippets, etc. For a quick overview on
HelpLogic basics, please read the How to Use HelpLogic page, or browse the rest
of this User Guide for details on specific features.
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How to Use HelpLogic

After you have created a new project (or opened an existing HelpLogic project), the
main project window that appears is the heart of the HelpLogic application. The
interface design provides a very intuitive, time-saving workflow for easily creating,
editing, and managing your project's table of contents, related HTML source files,
and project development notes, saved code snippets, etc. For options specific to
each of the three sections (Source Files, Table of Contents, Workshop), click on the
arrow button located at the top right of each section or select from the related menus
in the Menu Bar.

Step 1: Create Your Help Pages

The first thing you'll want to do is create your HTML help pages. Click on the "Add
File" toolbar button to add a new file or folder to the Source Files column in your
project. Click the "Edit Page" toolbar button to edit a selected file. Please see the
"Working with Source Files" section of this User Guide for details on Adding New
Files and Folders and Modifying Source Files.

Step 2: Build Your Table of Contents

Once you've created all of your help pages, you'll then want to build your Table of
Contents (TOC) as you would like it displayed in your published help system. The
TOC is the backbone of your help system, providing an organized listing of pages
and chapters, so that users can quickly browse the topics and find the information
they are looking for.

With HelpLogic's easy to use Visual TOC Builder, you can create an effective Table
of Contents that assigns an HTML help page and search/index keywords to each
topic. To create a new page in your TOC, select "New Page" from the "Add Topic"
toolbar menu. To create a new chapter in your TOC, select "New Chapter" from the
"Add Topic" toolbar menu. If you need to edit a selected TOC topic, either double-
click the selected item or click the "Edit Topic" toolbar button. Please see the "Visual
TOC Builder" section of this User Guide for details on Adding New Topics and
Modifying Topics.

Step 3: Preview and Publish!

If you want to preview how a page will display in a specific help viewer or web
browser, simply select an HTML file from the Source Files list or the Visual TOC
Builder and then choose a viewer from the "Preview" toolbar menu. The "Preview"
option is also available in the toolbar of HelpLogic's Code Editor. Please see the
Previewing Help Pages topic in this User Guide for details.
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When you are ready to publish your help pages (via the "Publish" toolbar button),
HelpLogic converts your project into the selected help format by using your TOC
data as a blueprint to build not only the Table of Contents, but also related link
references for the help system's search engine and index (if applicable). Please see
the "Publishing Help Systems" section of this User Guide for details on publishing
your help project for Apple Help, Microsoft® HTML Help, Web-based Help,
UniHelp or PDF.

Using the Window Menu

An open window in the background (such as an HTML file that's open in the
HelpLogic Code Editor) can easily be brought to the front by selecting it in the
Window Menu, which lists all currently open windows within HelpLogic.
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Adding New Files and Folders

Click on the "Add Files" toolbar item to add a new HTML file, CSS file, or folder to
your project. HelpLogic will ask you where in your source files folder you want to
save the new file or folder. If adding a new HTML file, you will then need to choose if
you want the new file to be created as a generic HTML file, a blank document, or an
HTML file with a selected page template. Read the Page Templates section of this
user guide for details on using page templates.

When adding a new HTML page to your Source Files, you are given the option to
also automatically create a new TOC Page Topic that's linked to that HTML page.
This saves you a couple extra steps.

Do not use any of the following names for files or folders in the root directory of your
source files folder: "index", "toc", "hltoolbar", "hltabs", "hlproject", "hlindex",
"hlwebdex", "hltoc", "hlsearch", "hlsearchform", "hlblank" and "hlimages". These
filenames are reserved by HelpLogic during the publishing process.

Since your source files get copied to your published Help, be careful not to use
accentuated characters or special entities in the file names of your source files and
folders, so that you don't run into any hyperlink problems in your published Help.

Importing Files and Folders

If you wish to import an HTML file from another project or location, click on the "Add
Files" toolbar item and select "Import File". HelpLogic will ask you to select the file
you wish to import and then ask where you wish to save it in your source files folder.
You may also import an entire folder of HTML pages into your project by selecting
"Import Folder" (also located in the "Add Files" menu underneath the "Import File"
option).

Refreshing the List

All changes should be reflected in the Source Files column, but if, for some reason,
the Source Files column does not reflect your most recent changes, simply click on
the arrow button at the top right of the column to display an options menu. From that
menu, select "Refresh List" to update the Source Files column.

File Properties

Select a file from the Source Files column and its file properties are automatically
displayed in the status bar at the bottom of the main project window.
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Modifying Source Files

Need to view, edit, rename, move, or delete one of your source files? Click on the
arrow button at the top right of the Source Files column to access an options menu.
From this menu, you can view/edit, move or delete the selected file. This contextual
menu can also be accessed by using your right mouse button or control-click a
single button mouse. You can also move a selected file via drag and drop to another
location within your Source Files list, such as an expanded sub-folder.

View/Edit Item

If the selected file is an image or multimedia file, then double-clicking the selected
item will open it in HelpLogic's built-in media viewer where you can view or play the
item.

If the selected item is an HTML file, then double-clicking the selected item will open it
in the default editor that you've specified in HelpLogic's Preferences. By default,
HelpLogic's built-in Code Editor is assigned, but you can assign any of the editors
listed in your Editors list to be your default editor in Preferences. See the the section
below "Using External Editors" for quick instructions on how to add new external
editors to your Editors list.

Using External Editors

If you don't want to use the built-in Code Editor, HelpLogic also lets you select your
favorite editor for viewing and editing your source files. Select "Modify Editor List"
from the "Edit Page" toolbar menu to add additional external editors to the "Edit
Page" toolbar menu list. Please note that only normal applications are supported.
Trying to add an editor that is a command line console application will produce a
shell error.

Move and Delete

Moving or deleting a selected file can be done by clicking the arrow button at the top
right of the Source Files column and choosing from the options menu. This
contextual menu can also be accessed by using your right mouse button or control-
click a single button mouse. When moving a file, HelpLogic will ask you where you
wish to move the file within your source files folder. You can also move a selected
file via drag and drop to another location within your Source Files list, such as an
expanded sub-folder. Please note that deleting a source file moves it to the Trash.
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Renaming Files

To rename a selected source file, click on the arrow button at the top right of the
Source Files column to access an options menu. This contextual menu can also be
accessed by using your right mouse button or control-click a single button mouse. If
you plan on publishing your help system in Web-based Help format for use on your
web site, do not use spaces or symbols that are not supported by HTTP, since your
TOC will be linking to these pages within your web browser. Your TOC will have
nice topic titles (with spaces), so your source file names do not.

Refreshing the List

All changes should be reflected in the Source Files column, but if, for some reason,
the Source Files column does not reflect your most recent changes, simply click on
the arrow button at the top right of the column to display an options menu. From that
menu, select "Refresh List" to update the Source Files column.

File Properties

Select a file from the Source Files column and its file properties are automatically
displayed in the status bar at the bottom of the main project window.
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The Link Manager

If you rename, move or delete a source file, HelpLogic will ask you if you want the
built-in Link Manager to check your HTML pages and Table of Contents for affected
link references.

The Link Manager first checks all hyperlink and image references in your HTML
pages as well as all link references in your Table of Contents to see if any links will
be affected by your action (to rename, move or delete a file). The Link Manager
window displays its findings and then asks you if you want those affected links to be
updated.

It is recommended to always allow Link Manager to update any affected link
references in order to prevent broken links from occurring in your help project.
Please note that when deleting a source file, all  affected HTML links that point to
that deleted file are replaced with an "#" anchor link, so as not to break your HTML.
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Relocating the Source Files Folder

If you had to move or transfer your HelpLogic project folder to a new directory or
another computer, HelpLogic should be able to successfully locate your Source Files
Folder when re-opening your project. If HelpLogic cannot find your Source Files
Folder based on its saved location, it automatically looks for a "Source" folder in your
project's main folder.

For some reason, if HelpLogic's "smart locator" cannot find your project's Source
Files Folder, you can relocate the Source Files Folder by clicking on the arrow
button at the top right of the Source Files column and choosing "Change Source
Folder" from the options menu. This contextual menu can also be accessed by using
your right mouse button or control-click a single button mouse within the Source
Files column.

IMPORTANT: Changing your Source Files Folder to a different set of source files
than originally used may invalidate your TOC topic links, so this feature is ONLY
recommended for those users who need to relocate their project's original Source
Files Folder.
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Editing HTML Content

To open a file in HelpLogic's built-in Code Editor, select a file in the Source Files
column and then choose "HelpLogic Code Editor" from the "Edit Page" toolbar menu.

HelpLogic's Code Editor displays HTML with syntax coloring, line numbering, and
many other convenient features. Useful information (such as the current line of the
cursor position) is displayed in the status bar at the top right of the Editor window
(just below the toolbar). Select Preferences from the HelpLogic application menu to
modify the editor's font size, display font and colors.

You can either manually type HTML code or you can use HelpLogic's handy Code
Plugins architecture to automate your HTML writing. HelpLogic includes more than
90 Code Plugins to help save you programming time. To access these Code
Plugins, use the toolbar at the top of the Editor window or use the contextual menu
(accessible by using your right mouse button or control-click a single button mouse).
Code Plugins are divided into convenient category toolbar menus. Need support for
additional HTML tags? Download the Code Plugins SDK and write your own Code
Plugins -- it's easy! See the Code Plugins section of this User Guide for details.

The Code Editor identifies the document's charset text encoding upon opening the
file, which is displayed in the status bar just below the toolbar. You can convert the
document to a different charset text encoding by selecting a different charset from
that pulldown menu. If you find the syntax coloring or text to be displaying incorrectly
when viewing double-byte Japanese and Chinese charsets, you might find that
changing the charset menu to UTF-16 may solve the issue.

If you need to search for a word or phrase in an open document or replace existing
text, select one of the "Find" options from the Tools menu.

Undo/Redo

Don't worry if you accidentally delete the wrong text or make a coding mistake. Just
use the handy Undo feature (in the Edit menu) to retract that last move.

Previewing Your Work

If you want to test your HTML code, you can preview your help page by choosing a
viewer/browser from the Editor's "Preview" menu.

Saving Your Work

To save your open file, you can either use the standard keyboard shortcut
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Command-S (Mac) or Control-S (Windows) or select "Save" from the "Editor" menu.

Using External Editors

If you don't want to use the built-in Code Editor, HelpLogic also lets you select your
favorite editor for viewing and editing your source files. Select "Add New Editor" from
the "Edit Page" toolbar menu to add additional external editors to the "Edit Page"
toolbar menu list. Please note that only normal applications are supported. Trying to
add an editor that is a command line console application will produce a shell error.
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Code Plugins

HelpLogic's built-in Code Editor utilizes an extensible plugin architecture, providing a
scalable solution to support additional HTML tags, custom scripts, etc. HelpLogic
includes more than 90 Code Plugins to help automate your HTML programming
efforts. To access these Code Plugins, use the toolbar at the top of the Editor
window. Code Plugins are divided into convenient category toolbar menus.

Need support for additional HTML tags? Download more Code Plugins from our
online Plugins Library or create your own HelpLogic Code Plugins!

If you already have experience writing HTML and web scripts (such as PHP or
JavaScript), then learning the Code Plugins API will be easy! Code Plugins are plain
text files with an .ehc file extension, so you can create them using any standard text
editor such as BBEdit or TextEdit (in Plain Text mode) on Mac OS X or NotePad on
Windows XP. Create plugins for your own use or drive valuable traffic to your web
site by sharing your plugin creations with the rest of the HelpLogic community.
Developers are invited to join our free Plugin Partners Program to list their plugin
offerings in our online Plugins Library. Download the Code Plugins SDK for details.

HelpLogic Code Plugins Library and SDK Download:
http://www.ebutterfly.com/helplogic/plugins.php

HelpLogic Plugin Partners Program:
http://www.ebutterfly.com/helplogic/ppp.php
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Editor Tools

Beyond Code Plugins, HelpLogic's Code Editor also includes a growing list of built-in
tools.

Special Characters

Can't remember the special HTML codes for all of those symbols and accentuated
characters? Not to worry. With HelpLogic, just select "Special Characters" from the
Editor's "Tools" menu and you can choose from a comprehensive list of HTML codes
for insertion into your current HTML document.

Find and Replace

If you need to search for a word or phrase in an open document or replace existing
text, select one of the "Find" options from the Tools menu.

If you need to do a project-wide Find and Replace, then close the open document
and choose "Find and Replace" from the Tools menu in the Main Project window.
See the Tools Menu page for details.
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How the Visual TOC Builder Works

Why build a Table of Contents? Because the Table of Contents (TOC) is the
backbone of your help system. Like a well-organized book, a good help system
provides a TOC listing of pages and chapters, so that users can quickly browse the
topics and find the information they are looking for. People do not read help pages
from beginning to end. They utilize help systems as reference guides to find specific
answers to specific questions, hoping to do so in as little time as possible.

The most important components of your help system are the TOC, index, and
search engine. Through HelpLogic's easy to use Visual TOC Builder, you can create
a well-organized Table of Contents that assigns an HTML help page and
search/index keywords to each topic. When you are ready to publish your help
pages (via the "Publish" toolbar button), HelpLogic converts your project into the
selected help format by using your TOC and its keyword and link references as a
blueprint.

For example, our Web-based Help format is not only cross-platform and cross-
browser compatible, but it also includes three selectable tabs (Contents, Index, and
Search) and a navigation toolbar to provide a comprehensive, intuitive, user-friendly
help experience. Your TOC chapters and pages are displayed in the Contents tab.
Your TOC keywords are displayed as an alphabetical index in the Index tab. And the
Search tab hosts a client-side JavaScript search engine that's powered by your TOC
titles, keywords, and descriptions.

So take special care to design a well-thought, organized Table of Contents, since
the way it looks in the Visual TOC Builder is exactly the way it will look in your
published help system.

The Visual TOC Builder includes icon buttons for "Source File", "Keyword Tags", and
"Description Tag". Single click on a Topic's "Keyword Tags" icon or "Description Tag"
icon to view that Topic's keywords or description respectively in the bottom status
bar. Single click on a Topic's "Source File" icon to view that Topic's source file path
in the bottom status bar. Control-click (Mac) on a Topic's "Source File" icon to Edit or
Preview that HTML file. Double-click a Topic's "Source File" icon to open it in your
default editor.
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Adding New TOC Topics

New Pages

To create a new page in your TOC, select "New Page" from the "Add Topic" toolbar
menu. HelpLogic will ask you to name your page and select the location in the TOC
where you want it saved. You will also be asked to assign an HTML page to this new
topic, so that when users click on the topic, the TOC knows what help page to
display. There are also fields for assigning keywords and descriptions to the
selected topic, which are very important so that users can search your help pages
and find the right results. Keywords are also used by help formats that support
indexes by listing linked keywords alphabetically.

Keywords should be separated with commas. For example: "first word, second
word, third word". This comma-delimited format allows HelpLogic to support multiple
word keyword phrases and Apple Help keyword conventions. Take special care to
craft meaningful keywords and keyword phrases since they are not only used in
searches but they will also be listed alphabetically in a help index. For example, in
Web-based Help, your TOC keywords are displayed as an alphabetical index in the
Index tab, and the Search tab's search engine scans your TOC keywords to find
related page matches.

New Chapters

To create a new chapter in your TOC, select "New Chapter" from the "Add Topic"
toolbar menu. HelpLogic will ask you to name your chapter and select the location in
the TOC where you want it saved.

Organizing Your Topics

Your TOC should start with a Page as your first topic (such as your introductory
page), and NOT a Chapter.

To rearrange your topics into the sequence you want, move each selected TOC
Page or Chapter via drag and drop to another position or into another TOC Chapter.

Your goal is to make your help system intuitive and easy to use. HelpLogic provides
a lot of assistance by publishing your help system with a professional interface and
innovative help technology, but your job is to find the best way to organize your
content for a truly effective TOC that's easy for users to navigate.
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Refreshing the List

All changes should be reflected in the TOC column, but if, for some reason, the TOC
column does not reflect your most recent changes, simply click on the arrow button
at the top right of the column to display an options menu. From that menu, select
"Refresh List" to update the TOC column.

File Properties

Select a page topic from the TOC column and its HTML source file path is
automatically displayed in the status bar at the bottom of the main project window.
The Visual TOC Builder also includes icon buttons for "Source File", "Keyword
Tags", and "Description Tag". Single click on a Topic's "Keyword Tags" icon or
"Description Tag" icon to view that Topic's keywords or description respectively in
the bottom status bar. Single click on a Topic's "Source File" icon to view that
Topic's source file path in the bottom status bar.
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Modifying TOC Topics

Editing Pages

If you need to edit a selected page topic, either double-click the selected item or click
the "Edit Topic" toolbar button and a Topic window will appear with the selected
item's properties. The Visual TOC Builder also includes icon buttons for "Source
File", "Keyword Tags", and "Description Tag". Double-click on a Topic's "Keyword
Tags" icon or "Description Tag" icon to edit that Topic's keywords or description.
Control-click (Mac) on a Topic's "Source File" icon to Edit or Preview that HTML file.
Double-click a Topic's "Source File" icon to open it in your default editor.

Beyond editing the topic's name and TOC location, you need to assign a valid HTML
page to the topic, so that when users click on the topic, the TOC knows what help
page to display. There are also fields for assigning keywords and descriptions to the
selected topic, which are very important so that users can search your help pages
and find the right results. Keywords are also used by help formats that support
indexes by listing linked keywords alphabetically.

Keywords should be separated with commas. For example: "first word, second
word, third word". This comma-delimited format allows HelpLogic to support multiple
word keyword phrases and Apple Help keyword conventions. Take special care to
craft meaningful keywords and keyword phrases since they are not only used in
searches but they will also be listed alphabetically in a help index. For example, in
Web-based Help, your TOC keywords are displayed as an alphabetical index in the
Index tab, and the Search tab's search engine scans your TOC keywords to find
related page matches.

Editing Chapters

If you need to edit a selected chapter topic, either double-click the selected item or
click the "Edit Topic" toolbar button and a Topic window will appear, allowing you to
edit the chapter name and TOC location.

Renaming Topics

To rename a topic, click the arrow button at the top right of the TOC column and
choose "Rename Item" from the options menu. This contextual menu can also be
accessed by using your right mouse button or control-click a single button mouse.
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Moving Topics

To rearrange your topics into the sequence you want, move each selected TOC
Page or Chapter via drag and drop to another position or into another TOC Chapter.
Moving a selected topic into a different parent chapter can also be done by clicking
the "Edit Topic" toolbar button and in the Topic window, change the "Located in"
pulldown menu to the new chapter location.

If your TOC is ever displayed incorrectly after a drag and drop move, you can fix this
by choosing "Refresh List" from either the Topics menu or the TOC contextual menu
(top right column arrow).

Deleting Topics

Deleting a selected topic can be done by clicking the arrow button at the top right of
the TOC column and choosing "Delete Item" from the options menu. This contextual
menu can also be accessed by using your right mouse button or control-click a
single button mouse. Deleting a chapter deletes all of the pages nested within it.
Please note that deleting a topic permanently erases it from the TOC.

Saving Your Work

To save your current TOC, you can either use the standard keyboard shortcut
Command-S (Mac), or select "Save" from the "File" menu.

Refreshing the List

All changes should be reflected in the TOC column, but if, for some reason, the TOC
column does not reflect your most recent changes, simply click on the arrow button
at the top right of the column to display an options menu. From that menu, select
"Refresh List" to update the TOC column.

File Properties

Select a page topic from the TOC column and its HTML source file path is
automatically displayed in the status bar at the bottom of the main project window.
The Visual TOC Builder also includes icon buttons for "Source File", "Keyword
Tags", and "Description Tag". Single click on a Topic's "Keyword Tags" icon or
"Description Tag" icon to view that Topic's keywords or description respectively in
the bottom status bar. Single click on a Topic's "Source File" icon to view that
Topic's source file path in the bottom status bar.
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Exporting Your TOC

If you're making major changes to your TOC that you may not want to be
permanent, you can periodically save backup versions of your TOC, just in case you
decide to go back to a previous version later in the authoring process.

It is very easy to export a backup version of your TOC by using the "Export TOC"
feature, accessible by clicking the arrow button at the top right of the TOC column
and selecting "Export TOC" from the options menu. From the Save As dialog window
that appears, choose a location where you wish to save your backup TOC file. By
default, HelpLogic provides a date-based filename for your convenience, such as
"HLTOC_2009-10-15.xml", but you may name the file whatever you want. Since the
backup file is in XML format, do NOT change or remove the .xml file extension.

To replace your project's TOC with a HelpLogic XML backup TOC file you saved,
click the arrow button at the top right of the TOC column and choose "Replace TOC"
from the options menu. From the Open dialog window that appears, simply select the
XML backup file that you wish to use. After the project's TOC is successfully
replaced with your backup TOC, save your project to lock in your new TOC data. For
more information on restoring your TOC with a backup file, please see the
Replacing Your TOC page.
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Replacing Your TOC

Why would you want to replace your project's current TOC (Table of Contents)? You
may wish to restore your project's TOC with a HelpLogic XML backup TOC file,
saved using the "Export TOC" feature.

IMPORTANT: Replacing your current TOC with a completely different TOC than
originally used may invalidate your TOC topic links, so this feature is ONLY
recommended for those users who need to restore the TOC with a backup file.

Using an XML Backup File

To replace your project's TOC with a HelpLogic XML backup TOC file, click the
arrow button at the top right of the TOC column and choose "Replace TOC" from the
options menu. From the Open dialog window that appears, simply select the XML
backup file that you wish to use. After the project's TOC is successfully replaced with
your backup TOC, save your project to lock in your new TOC data. For more
information on how to save a backup archive of your project's TOC, please see the
Exporting Your TOC page.
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The Workshop: Your Project Manager

Organize your development notes, code snippets, bug reports, "to do" lists, feature
requests, URL bookmarks and more with HelpLogic's built-in Project Workshop.

Tired of searching your hard drive for project-related files, e-mails, and code
snippets? Save time and effort by storing all of your project information in the
Workshop. Not only does the Workshop allow you to customize your work
categories and documents with an assortment of identifier icons and priority status
colors, but it also offers a comprehensive mix of data fields, powered by an ultra fast
XML engine.

Refreshing the List

All changes should be reflected in the Workshop list, but if, for some reason, the
Workshop list does not reflect your most recent changes, simply click on the arrow
button at the top right of the Workshop to display an options menu. From that menu,
select "Refresh List" to update the Workshop column.
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Workshop Categories

By default, the Project Workshop is populated with common development categories
such as "Notes", "Bug Reports", "Testing", "Feature Requests", "Code Snippets", etc.
You can choose to either use these existing categories or rename them or create
your own categories.

Adding New Categories

To add a new category to the Project Workshop, click on the arrow button at the top
right of the Workshop column and select "New Category" from the options menu.
The New Category window requires you to name your new category and assign it an
icon. Use the pulldown menu to choose from an assortment of available icons. All
categories are added to the root directory of the Workshop. You cannot nest
categories within existing categories.

Editing Categories

To edit a selected category, either double-click the selected item or click on the
arrow button at the top right of the Workshop column and select "Edit Item" from the
options menu.

Sorting Categories

To change the listed order of categories in the Workshop, drag and drop the
categories into the desired sequence. For example, this is helpful if you use the
"Code Snippets" category a lot and feel it would be more convenient to have it
located at the top of the Workshop list.
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Workshop Documents and URLs

Adding New Items

To add a new document or URL bookmark to the Project Workshop, click on the
arrow button at the top right of the Workshop and select "New Document" or "New
URL" from the options menu.

Within the Document window, you can assign the item to a specific category, give it
a priority status, document title, details/notes, and more. For storing bug reports and
feature requests, there are even data fields for saving customer information and
platform notes. If the Contact E-mail field contains an e-mail address, then clicking
the mail icon will open a new message to that address in your default e-mail
application. Clicking on the URL icon will load the URL field's web address in your
default web browser.

Within the URL bookmark window, you can assign the URL to a specific category,
give it a priority status, document title, and notes. If you want to test the URL before
saving it, simply click on the URL icon to load the URL field's web address in your
default web browser.

Editing Items

To edit a selected document or URL bookmark, click on the arrow button at the top
right of the Workshop and select "Edit Item" from the options menu. You can also
double-click a document to view or edit it. Double-clicking on a URL bookmark will
load that URL in your default web browser. It's easy to identify documents from URL
bookmarks by looking at the icon -- documents use a document icon and URL
bookmarks use a globe icon.

Saving Internet Searches

If you wish to save your current Internet search query from the Internet Search tool
(see the Tools Menu page), click the "Save Search URL" button in the Internet
Search window and the URL query string will be loaded into a new Project
Workshop URL bookmark window. Add a name to your new URL bookmark and
click "Save" to save your new URL bookmark in the Project Workshop.

About Priority Rankings

With both Documents and URL bookmarks, you can assign a priority status of either
"High", "Medium", or "Low". High Priority items are labeled in the Workshop with red
icons. Medium Priority items are labeled with orange icons and Low Priority items
use white icons. Items are listed in each category by priority with High Priority items
being listed first, followed by Medium and then Low.
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The Tools Menu

HelpLogic includes a growing number of tools and utilities in the "Tools" toolbar
menu. We'll be adding more features to this section in future releases.

Find and Replace

If you need to search and replace a word or phrase throughout your entire project,
select "Find and Replace" from the Tools menu in the Main Project window. You can
limit Find and Replace to only search your HTML Source Files, or you can enable
Find and Replace to also include your Table of Contents (TOC) in your searches.
You have options to perform case-sensitive searches and utilize Regular
Expressions as well.

After performing a search, a results list will appear at the bottom of the "Find and
Replace" window. Double-clicking on any of the listed HTML files or TOC topics will
open them.

If you only need to search within a single HTML document, then open that document
in the HelpLogic Code Editor and choose one of the "Find" options from the Code
Editor's Tools menu. See the Editor Tools page for details.

Find and Replace's Regular Expressions engine supports a modified version of the
PCRE library. For more information on PCRE-compatible expressions, please visit:
http://www.pcre.org/. Not all possible Regular Expressions have been tested in
HelpLogic's Find and Replace, so it is recommended to backup your HTML pages
and TOC before performing Regular Expressions in Find and Replace. If you find
any Regular Expressions bugs, please report them using our online support form:
http://www.ebutterfly.com/helplogic/support.php.

Internet Search

Need to research a topic or find a code snippet online? Use the built-in Internet
Search to search more than a dozen popular web sites. Just type in your
keyword(s), select the site you want to search from the pulldown menu, and then
click "Search". Your search results will be displayed in your default web browser. If
you wish to save your current Internet search query, click the "Save Search URL"
button in the Internet Search window and the URL query string will be loaded into a
new Project Workshop URL bookmark window. Add a name to your new URL
bookmark and click "Save" to save your new URL bookmark in the Project
Workshop.
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Page Templates

Selecting "Page Templates" from the "Tools" menu displays the Page Templates
library where you can add, edit or delete templates. If you find yourself using the
same page layout for many of your HTML help pages, then save yourself some time
by storing the HTML layout as a Page Template. The next time you add a new
HTML file to your source files folder, you can elect to save it with your custom Page
Template embedded in it.

Choosing "Edit" will allow you to open the selected page template file in either the
HelpLogic Editor or any other external code editor you have listed in HelpLogic.

HelpLogic's Page Templates currently work differently than what Dreamweaver
users may expect. Once you add them to a new HTML source file, that's where the
connection ends. If you later edit that page template, any HTML source files that use
that page template will NOT be updated. We plan to evolve the Page Templates
feature in a future HelpLogic release to offer additional functionality.
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Previewing Help Pages

If you want to preview an HTML page in a help viewer or web browser, simply select
an HTML file from the Source Files list or the Visual TOC Builder and then choose a
viewer from the "Preview" toolbar menu. By default, the "Preview" menu includes
UniHelp and Apple Help Viewer (Mac), but you can easily add additional viewers and
web browsers (such as Safari, Internet Explorer, Firefox and others) to that list by
selecting "Modify Viewer List" from the "Preview" menu. Please note that only normal
applications are supported. Trying to add a viewer that is a command line console
application will produce a shell error.

Preview from the Code Editor

If you want to test the HTML code of the current page you have open in HelpLogic's
Code Editor, you can preview it by choosing a viewer/browser from the Editor's
"Preview" menu.

HelpLogic 1.6 User Guide  31



Web-based Help Publisher

Our cross-platform help system for web browsers. Built with 100% pure client-side
JavaScript, CSS, and HTML, providing an ideal browser-based help solution for web
sites, complete with TOC, alphabetical keyword index, and JavaScript-powered
search engine.

The Web-based Help Publisher window allows you to customize the appearance of
your help system interface by choosing background colors, icon colors, font face,
font size, and more! HelpLogic includes a variety of icon colors to match whatever
background colors you decide to use for your toolbar, tabs, and left frame. The
handy diagram in the top right corner of the window gives you a display preview of
your chosen colors and options.

If you choose to assign either an Image Logo or Text Title Logo, then that logo will
appear in the top toolbar on the far right. The Margin setting affects the amount of
spacing around the Logo or Text Title. If you need additional space for tall logos, you
can also adjust the height of the top toolbar (the default is 30 pixels tall).

What gets published along with your help pages and Table of Contents is a
professionally designed help system interface, providing a comprehensive, intuitive,
user-friendly help experience. The toolbar includes optional navigational buttons
(Back, Forward, Home, Print) and three selectable tabs: Contents, Index, and
Search.

Those three tabs can be localized to the language of your choice. For your
convenience, HelpLogic provides presets for several languages.

Your TOC chapters and pages are displayed in the Contents Tab. When Web-
based Help is first displayed, the Contents tab is always the default selected tab,
providing the Table of Contents to users as the initial entry point into your help
system.

Your TOC keywords are displayed as an alphabetical index in the Index Tab. With
each index listing linked to its assigned TOC topic, the Index allows users to quickly
find and access information by browsing keywords and phrases.

The Search Tab hosts a built-in search engine that's powered by client-side
JavaScript, so NO additional scripting or CGI is required. The search engine scans
your TOC keywords to find related page matches.

If desired, you can opt to remove the navigation toolbar by selecting the "Remove
Toolbar" checkbox, but please note that without the toolbar, users will NOT have
access to the Index or Search features. Without the toolbar, only the Table of
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Contents will be available in the left frame for navigating through your help pages. If
the entire toolbar is removed, but you've opted to use an Image or Text Logo, then
that logo will appear in the Contents frame on the left. If you only want to remove the
navigation buttons and keep the three tabs, then only select the "Remove Toolbar
Buttons" checkbox.

By default, the main start page for your published help system is named
"index.html". If your web site already has an "index.html" file in the same directory
where you want to place your help files, you can now select the new Use Alt. Main
Filename checkbox to publish "indexhelp.html" as the main page filename of your
help system.

If you need to design your help system to be compatible with older web browser
versions that may not support CSS (Cascading Style Sheets), you have the option to
set the TOC Compatibility to the older HTML 3.2 format. For the best visual results,
the CSS/HTML option is highly recommended (especially since all modern web
browsers support CSS). Please note that when publishing, the TOC Compatibility
setting only affects the formatting of the TOC (Table of Contents) and not your own
help pages from the Source Files folder.

If your HTML source files use the ISO-8859-1 charset text encoding, then use that
same one for your TOC Char Set. If your HTML help pages use UTF-8, then assign
the TOC Char Set to UTF-8 for consistency. The TOC charset is used in the
Contents, Index, Search, and toolbar frames that HelpLogic dynamically generates
during the publishing process. For example, if the Contents, Index, and Search tabs
are localized to Japanese, then you would probably want to set the TOC Char Set to
UTF-8 to ensure that those Japanese characters display properly in a web browser.

Web-based Help even supports context-sensitive help! After you have published
your help system, you will find a "Context-Sensitive Help.txt" document in your help
folder that lists all of the special index files for linking directly to specific help pages.

Important Note: When selecting a publish location, do NOT choose a directory
within your source files folder. Publishing from your source files folder into your
source files folder will cause an endless loop, filling your hard drive with endless
folders. As of HelpLogic 1.0a2, the Publish feature does not allow you to select the
source files folder as your publish location.

When HelpLogic is run in Trial demo mode, Web-based Help Table of Contents are
limited to 3 topics per chapter. This publishing limitation is removed when you
purchase a license and register the application with your serial number.
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Apple Help Publisher

The standard Mac OS help format for Apple Help Viewer.

The Apple Help Publisher window allows you to customize the appearance of your
help book interface by choosing background colors, icon colors, font face and font
size, frame borders, and more! HelpLogic includes a variety of icon colors to match
whatever background colors you decide to use for your TOC frames. The handy
diagram in the top right corner of the window gives you a display preview of your
chosen colors and options.

If you choose to assign either an Image Logo or Text Title Logo, then that logo will
appear at the top of your Table of Contents frame.

You can also choose your own custom Apple Help Icon to be assigned as your
help book icon. When listed in Apple Help Viewer's Mac Help Center, this icon will be
displayed next to your help book name (if you properly registered your help book).
Choosing a custom help icon is strictly optional. For help books that do not include a
custom icon, the Mac Help Center simply displays a default Apple Help Icon next to
their names. If you do use a custom icon, make sure it is exactly 16 pixels wide and
16 pixels tall (72 dpi) and saved in GIF format.

What gets published along with your help pages and Table of Contents is full
support for Apple Help META tags, Apple Help Icon, etc. Based on the keywords
and descriptions that you added to your TOC page topics, the published Apple Help
page framesets will include the appropriate keyword and description META tags for
compatibility with the Apple Help Indexing Tool and Apple Help Viewer's search
engine.

IMPORTANT: The first topic in your TOC needs to be a Page so that the proper
Apple Meta Tags get included (such as AppleTitle and AppleIcon). If your first TOC
topic is a Chapter, then your published help will not get properly indexed or searched
by Mac OS X.

Starting with Mac OS X 10.3 Panther, Apple Help Viewer now supports CSS, but the
Apple Help Viewer in older versions of OS X and OS 9 only supports HTML 3.2. If
you need to design your help system to be compatible with the Apple Help Viewer in
Mac OS X 10.2 Jaguar and earlier, you have the option to set the TOC
Compatibility to the older HTML 3.2 format. If you are only designing for Mac OS X
10.3 Panther and higher, then the CSS/HTML option is highly recommended for best
visual results. Please note that when publishing, the TOC Compatibility setting only
affects the formatting of the TOC (Table of Contents) and not your own help pages
from the Source Files folder.
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If your HTML source files use the MacRoman text encoding, then use that same one
for your TOC Char Set for consistency. The TOC charset is used in the Contents
frame that HelpLogic dynamically generates during the publishing process. Be very
careful when setting a TOC Char Set, as well as when setting a charset tag in your
HTML source files. Apple's official Apple Help documentation warns that in versions
of Mac OS prior to 10.1, Help Viewer does not respect the charset tag when
rendering HTML. Furthermore, prior to Mac OS X 10.1, Apple Help Viewer supports
only a limited number of character encodings, such as the MacRoman,
MacJapanese, MacKorean, MacChineseTrad, and MacChineseSimp. Although
Apple Help Viewer in Mac OS X 10.1 and later renders Unicode content properly, it
currently does not index or search Unicode content. It has been recommended on
the Apple Help mailing list that for Chinese, use UTF-8 for best results. Otherwise,
for Latin-based languages like English, use a non-Unicode charset like ISO-8859-1.

HelpLogic even supports context-sensitive help for Apple Help! After you have
published your help system, you will find a "Context-Sensitive Help.txt" document in
your help folder that lists all of the special index files for linking directly to specific
help pages. See the Apple Help Documentation for details on how to call these help
links from within your software application. IMPORTANT NOTE: The "Context-
Sensitive Help.txt" document is for your reference only. This text file should be
removed from your help book folder BEFORE indexing your help book with the Apple
Help Indexing Tool (or Tiger's Help Indexer) or else the indexing utility will mistakenly
include that text file in your help book index.

Making Your Help Book Searchable

In order to make your Apple Help Book searchable
from within Apple Help Viewer, you must drop your
help book folder on the old Apple Help Indexing
Tool utility or the new Help Indexer to generate
the appropriate .idx or .helpindex files. If you do
not have the Apple Help Indexing Tool or the latest
Help Indexer, it is included with Apple's free
Developer Tools (available with the Mac OS X
installation disks or as a download from Apple's Developer Connection web site).

Help Indexer can create either .idx or .helpindex files. It is important to note that the
new .helpindex format was introduced in Mac OS X 10.4 Tiger and only works in
Tiger and Leopard. So for optimal compatibility ranging from Mac OS X 10.2 Jaguar
to 0.5 Leopard, you should generate both .idx and .helpindex files (which the Help
Indexer allows you to do).

NOTE FOR FRONTPAGE USERS: Microsoft FrontPage adds a lot of extra meta
tags and data to the HTML code that it generates for HTML pages. The Help Indexer
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and Apple Help Indexing Tool utilities are known to have problems with these
FrontPage meta tags. So if you use FrontPage as an external editor with HelpLogic,
be sure to remove those problematic FrontPage meta tags from your help pages
before using either the Help Indexer or the Apple Help Indexing Tool.

After creating the appropriate .idx or .helpindex files with the Apple Help Indexing
Tool or Help Indexer, in order for your Apple Help Book to be searchable from within
Apple Help Viewer and to be listed in the Mac Help Center Library menu, you must
also properly register your Apple Help Book with the OS within your application code
and related .plist files. Please see the Apple Help Documentation for details.

Apple Help Resources

For information on how to register your help book with the Mac Help Center from
within your software application, plus additional details on how to use special Apple
Help hyperlinks (which are supported by Code Plugins in HelpLogic's Code Editor),
please read the Apple Help Documentation. Below are some URLs for accessing the
Apple Help Documentation online.

Apple Help Reference (HTML Online)
http://developer.apple.com/documentation/Carbon/Reference/
Apple_Help/index.html

Apple Help Reference (PDF Download)
http://developer.apple.com/documentation/Carbon/Reference/
Apple_Help/apple_help.pdf

Apple Help Refererence for Leopard (Requires an ADC Account)
https://developer.apple.com/leopard/devcenter/docs/documentation/ 
UserExperience/HelpTechnologies-date.html

 
Important Note: When selecting a publish location, do NOT choose a directory
within your source files folder. Publishing from your source files folder into your
source files folder will cause an endless loop, filling your hard drive with endless
folders. As of HelpLogic 1.0a2, the Publish feature does not allow you to select the
source files folder as your publish location.

When HelpLogic is run in Trial demo mode, Apple Help Table of Contents are limited
to 3 topics per chapter. This publishing limitation is removed when you purchase a
license and register the application with your serial number.
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Microsoft HTML Help Publisher

The standard HTML help format for Microsoft Windows®, utilizing the MS HTML Help
Viewer.

The Microsoft® HTML Help Publisher window allows you to customize the
appearance of your help interface elements by choosing a CHM topic icon, font face,
font size, default topic, and more! Please note that the Language setting refers to
Microsoft elements and does NOT translate your HTML help pages.

What gets published along with your help pages and Table of Contents are all of the
required configuration files for compiling your help pages into a single CHM file. You
can use either the uncompiled help pages or a compiled CHM file with the MS HTML
Help Viewer.

Using the Uncompiled HTML Help

Like the Web-based Help format, the uncompiled HTML Help features three tabs:
Contents, Index, and Search. Your Table of Contents (TOC) is displayed in the
Contents tab. Your TOC keywords are displayed as an alphabetical index in the
Index tab. And the Search tab hosts a client-side JavaScript search engine that's
powered by your TOC keywords. The major difference is that the interface is
designed to emulate the look and feel of a compiled CHM file with gray tabs, purple
book icon, and yellowish document icon. If you do not have access to Microsoft's
free HTML Help Workshop (to compile the CHM file), then you can easily use the
uncompiled version of your HTML Help in the MS HTML Help Viewer.

Those three tabs (Contents, Index, Search) can be localized to the language of your
choice. For your convenience, HelpLogic provides presets for several languages.

If you need to design your help system to be compatible with older operating
systems such as Windows 98 that may not support CSS (Cascading Style Sheets),
you have the option to set the TOC Compatibility to the older HTML 3.2 format. If
you are only designing for more recent versions of Windows (such as Windows 2000
and XP), then the CSS/HTML option is highly recommended for best visual results.
Please note that when publishing, the TOC Compatibility setting only affects the
formatting of the TOC (Table of Contents) and not your own help pages from the
Source Files folder.

If your HTML source files use the ISO-8859-1 charset text encoding, then use that
same one for your TOC Char Set. If your HTML help pages use UTF-8, then assign
the TOC Char Set to UTF-8 for consistency. The TOC charset is used in the
Contents, Index, Search, and tab frames that HelpLogic dynamically generates
during the publishing process. For example, if the Contents, Index, and Search tabs
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are localized to Japanese, then you would probably want to set the TOC Char Set to
UTF-8 to ensure that those Japanese characters display properly in a web browser.

The uncompiled version even supports context-sensitive help! After you have
published your help system, you will find a "Context-Sensitive Help.txt" document in
your help folder that lists all of the special index files for linking directly to specific
help pages from within your software application. The link protocols for context-
sensitive help within a compiled CHM file are different, so please see the Microsoft®
HTML Help Documentation for details on how to call these help links from within
your software application.

Compiling Your Help Pages into a CHM File

If you prefer not to use the uncompiled version of HTML Help and wish to distribute
a single CHM help file with your software, your published help folder includes all of
the required configuration files needed to compile a CHM file. To make a CHM file,
you'll need Microsoft's HTML Help Workshop utility, which is available online as a
FREE download (visit the SDK Downloads URL below).

If you look in your published help folder, you'll see three documents with unique file
extensions: hlproject.hhp, hltoc.hhc, and hlindex.hhk. These are the configuration
files that tell HTML Help Workshop where to find your help pages and how to build
the custom TOC, Index and Search for your CHM file. Do NOT move these files --
leave them in the same root directory as your HTML pages (inside your published
help folder).

Once you have the free HTML Help Workshop utility
installed and running, you'll see an "open folder" icon
button in it's toolbar. Click it and choose the
hlproject.hhp file to open your help project in HTML
Help Workshop.

Once the hlproject.hhp file is open in HTML Help
Workshop, simply click the "grinder" icon button (to the
right of the open button) to compile your HTML Help
into a single CHM file. It's that easy! No manual editing
is required since HelpLogic already configured all of
the compile settings! Your compiled CHM file will be
saved in your published help folder with the filename
you specified in HelpLogic's "Name for CHM File" field.

Important Note: Within a CHM file, the search engine lists page matches using their
HTML title tag, so be sure to use a descriptive phrase for the HTML title tag of each
help page BEFORE publishing.
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Microsoft® HTML Help Resources

For information on how to integrate MS HTML Help into your software application,
plus additional details on how to use special CHM-to-CHM hyperlinks (which are
supported by Code Plugins in HelpLogic's Code Editor), please read the MS HTML
Help Documentation. Below are some URLs for accessing the MS HTML Help
Documentation online, and downloading HTML Help Workshop and CHM versions of
the documentation.

Microsoft® HTML Help Documentation
http://msdn.microsoft.com/library/en-us/
htmlhelp/html/vsconhh1start.asp

Microsoft® HTML Help SDK Downloads
http://msdn.microsoft.com/library/en-us/
htmlhelp/html/hwmicrosofthtmlhelpdownloads.asp

 
Important Note: When selecting a publish location, do NOT choose a directory
within your source files folder. Publishing from your source files folder into your
source files folder will cause an endless loop, filling your hard drive with endless
folders. As of HelpLogic 1.0a2, the Publish feature does not allow you to select the
source files folder as your publish location.

When HelpLogic is run in Trial demo mode, MS HTML Help Table of Contents are
limited to 3 topics per chapter. This publishing limitation is removed when you
purchase a license and register the application with your serial number.

Microsoft is a registered trademark of Microsoft Corporation. All Rights Reserved.
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PDF Publisher

Publish your help pages as a single PDF file, complete with a custom title page, table
of contents, PDF bookmarks, page numbering and formatting. You have the option
to use your own custom HTML title page or have HelpLogic generate a generic title
page.

HelpLogic's PDF Publisher is perfect for producing electronic user guides and e-
books. If you need to create printed paper-based documentation, then publish your
help pages as a PDF file and then print the PDF to paper.

When HelpLogic is run in Trial demo mode, the published PDF's Table of Contents
is limited to 3 topics per chapter. This publishing limitation is removed when you
purchase a license and register the application with your serial number.

HTML Authoring Tips for PDF Publishing

Styles: If you want to use different styles and colors for the way text and
hyperlinks display in PDF, but still retain your original styles for publishing in
other help formats such as Web-based Help, then the easy solution is to link
to external CSS files. In the stylesheet link meta tags, assign the media
attribute to "screen" for web styles and "print" for print styles. For example,
within your head tag, include:
<link media="screen" type="text/css" rel="stylesheet" href="style_web.css">
<link media="print" type="text/css" rel="stylesheet" href="style_print.css">
In your external CSS files, you can include your web-related styles in the
"style_web.css" file (such as blue, underlined hyperlinks) and your PDF-
related styles in your "style_print.css" file (such as black hyperlinks).
 
Forced Page Breaks: If you want to force a page break in the middle of a
topic, then add the following CSS style where you want the page break to
occur. This print-related CSS code should not affect the HTML display in a
web browser. This example shows the CSS style in a paragraph tag, but you
could also create your own CSS class that calls this style:
<p style="page-break-before: always"></p>
 
Image Placement: If an image in one of your HTML help files gets cut-off at
the bottom of a PDF page (with the remainder of the image displayed at the
top of the next PDF page), the easy way to fix this is to move the placement
of the aligned image in your HTML source code to avoid that page break. For
example, if only a little bit of the image bottom gets cut-off by the page break,
then simply move the image up a few lines in your HTML code, moving it
away from where that page break will occur when published to PDF.
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HTML Table & Image Widths: If your text and images run off the right edge
of the PDF page, then the cause is usually due to HTML tables and/or
images with set widths that are greater than the printable width of the PDF
page. HTML resolution is 72 pixels per inch, so if you are printing to a PDF
page size of 8.5 inches wide, but have assigned a page margin of 0.5 inch
on the left and right margin, then that means your printable width is 7.5
inches. 7.5 X 72 pixels = 540 pixels. So in order to ensure that your images
and text do not run off the edge of your PDF page, you need to make sure
that none of your HTML tables or images have widths set at anything wider
than 540 pixels. If an HTML table width needs to span the entire width of the
PDF page, then it's safer to use width="100%" instead of a set pixel number.
 
PDF Publisher (Mac OS X): If you find that changes made to your external
CSS stylesheets are not being published to PDF, that is not a bug in
HelpLogic, but a bug in Apple's WebKit framework. HelpLogic's PDF
Publisher utilizes Mac OS X's built-in WebKit framework to render/parse your
HTML pages. For some reason, WebKit will sometimes use an older cached
version of your external CSS file instead of using the most recently updated
version. The same problem occurs in Safari browser sessions. Often the only
way to get WebKit to recognize/load the latest version of your external CSS
file is to quit HelpLogic in order to "reset" WebKit. Safari browser users often
have to quit Safari to "reset" WebKit when encountering the same kind of
caching issues. Apple is aware of the issue and when they fix it in WebKit, it
will automatically be fixed in Safari, HelpLogic, and any other Mac application
that utilizes the WebKit framework.
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UniHelp Publisher

Our award-winning, cross-platform help system for REALbasic developers.

The UniHelp Publisher window allows you to customize the appearance of the
UniHelp module interface by choosing the icon colors, font face, window
size/position, and more! When publishing your help pages, TOC, and Index for
UniHelp, HelpLogic generates customized REALbasic code for the UniHelpEngine
constructor and saves it in your new help folder in a document called
"Code_for_UniHelp.txt".

Publishing a UniHelp Virtual Volume

To publish your UniHelp pages as a Virtual Volume, select the .vv checkbox next to
the "Help Folder Name" field. Once checked, you will notice that the field's name
changed to "Help Virtual Volume Name". The published help will be saved as a
single Virtual Volume file with a .vv extension. Located in the same directory as your
published Virtual Volume will be a "Code_for_UniHelp.txt" document that includes
your customized code for your REALbasic project. Pay special attention to the fact
that this generated REALbasic code is different for Virtual Volumes than standard
help folders.

Virtual Volumes CANNOT be opened from read-only locations such as Mac OS X
disk Images, CD-ROMs, DVDs, or locked drives/disks. If you need your application
to access help pages from a read-only location, then you should publish your
UniHelp pages in a standard help folder.

Developing for Older Versions of UniHelp

With UniHelp 4 now available, older UniHelp versions are no longer supported, so
preview and publishing options for those obsolete versions have been removed from
HelpLogic. Since UniHelp 3 and higher supports standard HTML/CSS, the special
UniHelp Page Editor is no longer needed and has been removed from HelpLogic.
The built-in HelpLogic Code Editor (or any external editor) can be used for creating
HTML pages for UniHelp 3 and higher.

Publishing Your Old UniHelp 1.x Pages in Other Help Formats

When importing your UniHelp 1.x Pages into a new project (using the "Import Set"
feature), the project's Table of Contents is automatically generated based on your
UniHelp 1.x file naming and numbering scheme. You will still need to add your own
custom keywords to the TOC topics, but the generated TOC will have saved you a
lot of time when publishing your help pages in other help formats that use the TOC
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(such as UniHelp 3, Web-based Help, etc.)

Important Note: When selecting a publish location, do NOT choose a directory
within your source files folder. Publishing from your source files folder into your
source files folder will cause an endless loop, filling your hard drive with endless
folders. As of HelpLogic 1.0a2, the Publish feature does not allow you to select the
source files folder as your publish location.

For detailed instructions on how to use UniHelp, please see the UniHelp
documentation (included in the UniHelp download).

If you're a REALbasic developer who is unfamiliar with our popular UniHelp
component, you can find more information and download the trial version at:
http://www.ebutterfly.com/rb/unihelp.php
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Saving Your Publisher Settings

If you are constantly publishing new versions of your
help systems, then you'll want to take advantage of
HelpLogic's ability to save your custom publisher
settings. This enables the Publisher window to be
pre-configured with your settings the next time you
need to publish the same project. Your publisher
settings are saved into your project database so
EACH project can store its own unique publisher settings for EACH format (Web-
based Help, Apple Help, MS HTML Help, etc.). To activate this time-saving feature is
a simple 2-step process.

First, select Preferences from the HelpLogic application menu (Mac). In the
Preferences window, there is a box called "Publisher" where you can select "Use
Saved Custom Settings". Once that option is selected, click the Apply button to
save your new Preferences. This tells HelpLogic to populate the Publisher window
with the custom settings saved in your project database the next time you use the
Publisher. Default settings are used until  custom settings have been saved.

That first step tells HelpLogic to use the saved publisher
settings from your project database, but now the second
step is to tell HelpLogic which settings to save. The next
time you use the Publisher, you'll notice a checkbox in
the top right corner called "Save Current Settings". If you wish to save the settings
for that Publisher session, make sure that checkbox is selected BEFORE clicking
the Publish button. That tells HelpLogic to overwrite the existing saved settings with
these new settings after publishing your help pages. If you do NOT wish to save the
settings from the current Publisher session, leave that box unchecked, which in turn
preserves your existing saved settings.

The advantage of using this 2-step process is the configuration flexibility it provides.
If you need to revert back to using the default publisher settings WITHOUT erasing
your saved settings, simply change the Preferences option back to "Use Default
Settings" and leave the Publisher window's "Save Current Settings" unchecked. If
you want to experiment publishing with modified versions of your saved settings
WITHOUT overwriting your saved settings, simply select "Use Saved Custom
Settings" in the Preferences window and leave the Publisher window's "Save Current
Settings" unchecked.
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About the Trial Version

This trial download is fully-functional and never expires. Until  registered with a
purchased serial number, sessions are limited to 15-minutes, and Apple Help, Web-
based Help, Microsoft HTML Help, and PDF Table of Contents are limited to 3 topics
per chapter when published. These limitations are removed when you purchase a
license and register the application with your serial number.

System Requirements:

Mac OS X 10.4 or higher (Leopard-compatible).
40 MB available RAM.
55 MB free hard drive space.

To be notified about updates, subscribe to our free RSS News Feed or our free
Email News Alerts at our web site: http://www.ebutterfly.com
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How to Purchase

If after trying HelpLogic, you realize that it's a software application that you wish to
keep, then please purchase a license online. A single user license includes unlimited
e-mail customer support.

Purchase HelpLogic for only US $99
Order online today at http://www.ebutterfly.com/helplogic/

To register/unlock the full version of HelpLogic:

1. Choose "Register HelpLogic" from the HelpLogic Help Menu. When the
Register window appears, click the "Purchase" button, which will open your
default web browser to the SECURE order form on our web site (Internet
connection required).

2. Submit the online order form. Once your purchase is completed, an order
confirmation will be e-mailed to you. The order confirmation e-mail includes
your unique serial number which you can then copy and paste into the Serial
Number field in HelpLogic's Register window. In the Name field, be sure to
use the exact customer name that is listed in your order confirmation.

3. Once your name and serial number are added to HelpLogic's Register
window, click the "Register" button to finish the registration, unlocking the full
version of HelpLogic for you to enjoy!

IMPORTANT: Please save your order confirmation information in a safe place, since
you will be required to provide your serial number when requesting e-mail customer
support and/or installing software upgrades.
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Customer Support

If you run into any problems while using HelpLogic, please refer to this User Guide
first to see if it lists quick answers to your questions. If the User Guide does not
solve your problem, or you wish to submit comments or feature requests, you are
encouraged to contact Customer Support at:

http://www.ebutterfly.com/helplogic/support.php

Troubleshooting

Invisible Project Window: After choosing a project to open in HelpLogic, if
the project loads, but the main project window never appears onscreen, then
try the following: quit the application, delete HelpLogic's Preferences files,
and then re-launch HelpLogic to see if that resolves the issue. On Mac OS X,
delete the HelpLogic folder and com.electricbutterfly.helplogic.plist in the
"User/Library/Preferences/" directory.

Known Issues

Mac OS X 10.5 Leopard: Small memory leak on Mac OS X 10.5 Leopard
when opening and closing some windows (such as the Publisher windows).
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